Emergency Room

MBPF Chapter 3, Exercise 4 Implemented in iGrafx
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Background
The Managing Business Process Flows (MBPF) book gives methods to calculate the approximate
behavior of a process. You may use a Discrete Event Simulator (DES) like iGrafx Process® or
iGrafx Process for Six Sigma® to replicate the behavior given in the process. In addition, you
may also set up the simulation model in such a way that the simulator will give you additional
information than that given in the book; for various different modeling parameters that you
choose. The iGrafx simulation model allows you to build a general-purpose problem-solving and
prediction tool. You can do “what-if?” changes to the existing process flow, and even do
contingency planning such as what would happen if different demands (e.g., rate of incoming
patients) were placed on the process.
For this exercise, we show you how to model a process flow in iGrafx.

Modeling Overview
Using iGrafx to simulate requires understanding several concepts. We will first give sources of
information for getting familiar with iGrafx. We will then cover the environment the simulation
runs within, the properties of each activity that control the flow of transactions (flow units)
through the process flow chart, and finally will cover how to run a simulation and interpret the
results.

Getting Familiar with iGrafx
To become familiar with iGrafx, and in particular iGrafx simulation, please refer to the reference
material provided in the Appendix of the MBPF book, and to the additional information on the
CD included with the book. Please note that an electronic copy of the iGrafx Process User Guide
is also included in the CD. We also encourage you to use the tutorials included with iGrafx (from
the Help menu in iGrafx, please choose “iGrafx Tutorials…”), and/or receive training on iGrafx,
before using it for simulation. For more information on iGrafx, visit http://www.iGrafx.com.
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Please note that the pictures of dialogs and menus given here may differ slightly from how they
look on your screen, due to screen resolution or operating system differences. In particular, your
view of the Properties dialog tabs may look different.

The Model Environment: The Scenario
The Scenario contains the information that is needed to run simulation; beyond that which is
given in the process map. To review the information in the Scenario— including length of
simulation, arrival patterns, resources, and so on— use the Model menu. In particular, the Run
Setup, Generators, Resources, and Schedules commands determine how long the simulation runs,
how flow units or transactions (in this case, patients) arrive, how many resources are available to
do the work, and what schedule controls those resources.
In addition to the Model menu, you may also use the Modeling Toolbar; which shows the
controls for running simulation, and also for Run Setup, Generators (the lightning bolt),
Resources (the person), etc.

You may also view a summary of the Scenario information in the Scenario window.
To view the Scenario window, click the View Scenario button on the Modeling toolbar shown
above
, or use the Explorer Bar. To use the Explorer bar, from the View menu, choose
Explorer. In the resulting Explorer Bar window, double-click on the scenario to view the Scenario
window. A portion of the iGrafx application, showing the Explorer Bar, is shown below:

Activity Properties
In addition, each activity (step in the process flow chart) provides information needed for
simulation; information such as the time needed to perform the activity (duration), specific
resources needed at that activity, and so on. You may review how each activity specifies
information by reviewing the Properties associated with the activity shapes themselves. You may
review activity properties by double-clicking the activity, or by right-clicking on the activity and
choosing Properties. For example, if you double-clicked on the Registration activity and clicked
on the Task tab, the Properties dialog would look like the following:
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Please note that iGrafx processes the tabs roughly in left-to-right order. That is, first Inputs are
processed from the path(s) entering the activity, then Resources are acquired, the Task is
performed, and then Outputs are processed down the appropriate path(s) leaving the activity.

Model Implementation
We will first review the setup of the Scenario, which is the environment the simulation runs in.
Then we will review the properties of each activity, which indicate to the simulator how each
transaction flows through the process flow chart.

Simulation Run Setup
The simulation is set up to run for 10 weeks, in order to collect a large statistical sample. In
addition, we have defined that the ER is always open; the default schedule will be “Always”, or
open 24 hours a day, 7 days a week. To review how the general setup for simulation is defined,
from the Model menu, choose Run Setup. You will see that, in addition to how long simulation
runs, other factors such as when simulation starts, where simulation report data is written, and
other general setup for the simulation run has been defined. Be sure to click on the various tabs to
review all information:
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Generators (Arrival Pattern)
Per the MBPF book, arrival to the ER is at a rate of 55 patients per hour, exponentially
distributed. This is modeled by the generator associated with the start activity, which generates
and introduces transactions into the process. The generator is defined in the Model menu, using
the Generators command. We use an “Interarrival” type generator, which indicates the interval
between arrivals is an exponential distribution around a mean of 1.09 minutes. There are other
types of generators, which may be reviewed in the iGrafx Help menu or documentation. The
generators dialog looks like the following:
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Resources
The MBPF example for Chapter 3 mentions the types of resources needed; we will use 7 Doctors
and 2 Nurses. A later MBPF chapter discusses resource constraints, and how they affect the
process behavior. We have modeled specific resources that would be needed in an ER, so that you
may see how these resources are implemented.
We have defined that Nurses perform Registration of the patient. The Nurse is, and other types of
resources are, defined using the Model menu, using the Resources command. When you choose
Model and then Resources, the Resources dialog displays:

Note that we have set the Nurse, and Doctor, resource to the count (or number) mentioned above.
In addition, we have set the built-in Worker type resource, which we are not using for this model,
have an “unlimited” count. Setting the “Worker” resource to unlimited means that we will not
limit the simulation behavior by this resource. We do this so that we do not accidentally limit the
process if we leave a “Worker” specified as a resource in an activity.

Activity Properties
We will now review the properties of the activities themselves. It is these properties, together
with the information in the Scenario, which will tell the iGrafx simulator how to move each
transaction through the process flow.
If you cannot see the entire process map (flow chart) on your screen, please choose “All” from
the zoom drop-down menu on the Standard toolbar, shown near the right edge of the picture
below:
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Let’s return to the discussion of resources. We have also determined that each patient needs one
Nurse to register them. How the Nurse is acquired by the patient may be seen on the Resources
tab of the Properties dialog for the “Registration” activity. Again, to view the properties of any
activity, simply double-click on the activity. Then click on the tab you’re interested in. For
example, the Resources tab of the Registration activity looks like the following:

The first drop-down menu, which displays “Nurse” in the picture above, specifies that it is the
Nurse resource we need for this activity. The “Activity” type of acquire for the Nurse (shown in
the drop-down menu to the right of the first drop-down menu that specifies the “Nurse” resource)
indicates the Nurse is acquired and released in this activity. The acquisition of the Nurse occurs
before the duration given in the Task tab, and the Nurse is released after the activity task duration
is finished. We are only specifying that the Nurse is needed for this activity; other activities may
or may not specify the Nurse resource is to be used.
To review how long the “Registration” task takes, click on the Task tab of the Properties dialog:
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You can see it takes a between 1.75 and 2.25 minutes, distributed uniformly… or, said another
way, the time it takes to register a patient is equally likely to take anywhere between a minimum
of 1.75, and a maximum of 2.25, minutes.
With the Properties dialog shown, you may now simply click on the “Greet the Patient” activity
and click on the Resources tab to see how a Doctor is acquired (if you had made changes, it is not
necessary to click Apply first; iGrafx will automatically apply any changes you have made when
you click on another activity):

Notice that the Doctor is acquired using the “Acquire” rule in the drop-down menu next to the
Doctor resource name. The “Acquire” rule indicates that the resource should remain acquired by
this transaction until released later; it is a convenient way to indicate you wish to use a resource
for multiple activities. The Doctor is acquired in the “Greet the Patient” activity, to show that the
patient will be waiting for a Doctor before being greeted, and is released either after ordering a
prescription for the patient, or after a detailed examination; depending on whether the patient had
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a serious condition or not. The release of the Doctor is done on the Resources tab of the
Properties dialog for the “Order Prescription” and “Detailed Examination” activities; as the
transaction (patient) may follow either path.
Again, you may review the duration of the activities that the Doctor performs by clicking on
(selecting) them and displaying the Task tab of the Properties dialog. You will see that ordering a
prescription is described by its time of 4-6 minutes, and the detailed examination takes anywhere
between 20 to 40 minutes.

Decisions
We route patients based on a decision activity labeled “Serious?” You may review how the
patients are routed by checking the Outputs tab of the properties of the decision activity.
You will see that the statistical percentage chance that a patient is not serious is 90%, and they
will thus follow the “No” path, have a prescription ordered for them, and be discharged from the
ER. The other 10% are serious, and will follow the “Yes” path to a detailed examination and
admittance to the hospital.
The Properties dialog for the “Serious?” decision is shown below:

Monitoring Transaction Statistics
Because there are different types of patients completing the process, those who are admitted and
those who are discharged, we can monitor each type of patient independently. To do so, we have
used “monitors.” A monitor is placed on one or more activities, and is an indication to the
simulator to gather statistics at, and/or from, a specific activity.
To view and modify monitors, from the Model menu, choose Monitors. This will display the
Monitors tab of the Modeling window:
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We have defined two monitors: One to track those patients discharged from the ER
(“Discharge”), and those admitted to the hospital (“Admit”). The monitors are placed on specific
activities; this tells iGrafx to collect statistics at those activities and allow them to be reported on
separately. The report, described later, has been customized to show information from these
monitors.

Tabular View
A faster method to review the Properties of, and other information for, multiple activities at once
is to use the “Tabular” view of the process. To enter Tabular view, from the View menu, choose
Tabular. To return to the normal, graphical view of the process, from the View menu, choose
Normal. When in tabular view, the columns of data shown may be configured from the View
menu with the Columns command. A portion of the tabular view is shown below:

Running Simulation
Now that we have reviewed the simulation modeling environment (the Scenario), and the
properties of the activities in the process, we are ready to run a simulation. If you would like to
run the simulation with animation, you must first enter “trace” mode. To run simulation as fast as
possible, do not use trace mode, and simply start the simulation run as described below. Either
way, you must run a complete simulation to receive simulation results summarized in a report.

Tracing (Animating) Simulation
You may trace, or animate, the simulation run. Trace mode is useful both to understand the
behavior of the process, and also to verify that your model exhibits proper behavior.
To enter trace mode, from the Model menu, choose Run and then Trace. By default, this displays
the Transactions window (if it does not, from the View menu, choose Transactions) so that you
may see the status of each transaction. In addition, the Trace toolbar is displayed, so that you may
pause, stop, and/or control the speed of simulation:
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When in trace mode, you must still run the simulation. Please see the section below on running
simulation.

Running Simulation
To simulate the process, from the Model menu, choose Run and then Start. You may also press
the Start/Resume button on either the Model toolbar or Trace (if you are in trace mode) toolbar; it
is the one that looks like the “play” button of your CD player.
If you are in trace mode, as the process is simulated you will see the activities change colors
according to how transactions are flowing through the process. You may show the meanings for
these colors by going to the Control menu, and choosing Trace colors. Please note that you must
run a complete simulation while in trace mode in order to see the simulation results. If you are not
in trace mode, simulation will run in the background, and produce a report.

Simulation Results
Overview
After the simulation completes, the results can be read in the report. The report contains
information already configured for you; organized into 5 tabs: Time, Cost, Resource, Queue, and
Custom. Each tab summarizes statistics based on the category given; the first 4 tabs summarize:
The time that transactions (flow units) take to flow through the process, the cost to process the
transactions, how well resources were utilized, and what sort of queuing or waiting occurred. The
Custom tab is usually a blank “scratchpad” for you to collect, or even create, statistics of your
own. Some statistics have been collected for you already on the Custom tab of the report.

Exercise 3.4, Question 1
The question asked is “On average, how long does a patient stay in the ER?” This is asking for
the average flow time. To find the answer, please click on the Custom tab in the report. If you are
not looking at the report window, you may open it by double-clicking it in the Explorer Bar, or by
clicking the right-most button on the Model toolbar.
The average time a patient spends in the emergency room, or the Average Cycle Time of a
transaction as iGrafx calls it, can be seen in the first table on the Custom tab. This table is also
called a Report Element, as the information it summarizes can also be shown as a graph. Note
that this is a simplification of a report element in the Time tab of the report, which also shows
average working and waiting times:

Average Flow (Cycle) Time in Minutes
51.88
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Exercise 3.4, Questions 2 and 3
Questions 2 and 3 ask how many patients, on average, are either being examined by doctors
(question 2) or in the ER overall (question 3). In other words, we want the average inventory of
patients either being examined by, or waiting for, doctors; and the inventory of patients in the ER
overall.
To find the average inventory of patients in the ER, we will look at the time-weighted average
number of transactions at each activity. Time-weighting statistics gives a perspective not only of
how many transactions were waiting, for example, but also how many were waiting for how long;
it adds the element of time, and provides a more accurate picture than a simple average.
The average number of patients, on a time-weighted basis, that are at each activity is shown in the
2nd report element. This data may also be seen as part of a report element on the Queue tab of the
report; we have customized the report to only show the one statistic we are interested in:

Average Inventory (Time-Weighted Average Number of Transactions) @ Activity
01 - Start

0.00

02 - Registration

6.65

03 - Greet the Patient

34.27

04 - Serious?

0.00

05 - Order Prescription

4.14

06 - Discharge from ER

0.00

07 - Detailed Examination

2.77

08 - Admit to the Hospital

0.00

We can use this 2nd report element to calculate the average number of patients being examined by
a Doctor. Simply add the time-weighted average number of transactions at activity for the
activities labeled “Greet the patient”, “Serious”, “Detailed examination” and “Order
prescription.” To get the time-weighted average number of patients in the entire ER at any one
time, add all the numbers shown in the second report element.
If you wish to use a spreadsheet, such as Microsoft Excel®, to do calculations on inventory
levels, you may copy and paste the iGrafx report element to the spreadsheet. To do so, select the
report element by clicking on it. Then press Ctrl-C; or from the Edit menu, choose Copy. Now
you may go to Excel and choose Ctrl-V, or from the Edit menu, choose Paste.

Exercise 3.4, Additional Information
There is additional information given in the Custom tab of the report. In particular, the
information shows you how to calculate flow rates, and gives supporting information to use
Little’s Law to find flow rates, flow times, and/or inventory levels.
The 3rd and 4th report elements shows the number of patients that completed the process (were
treated or admitted to the hospital), and the amount of time that elapsed during simulating
treatment of patients. We can use this information to calculate an overall flow rate of the process:
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Overall Transaction (Patient) Completion Count
92929
Elapsed Time (Hours)
1680.00

We have defined a Custom Statistic in iGrafx to perform the calculation of flow rate. To review
how the custom statistic is defined, from the Report menu, choose Custom Stats.
Custom Statistics :
Count : Completion Count
Average_Flow_Rate = Count / Hours(Time)

The custom stat will calculate Average Flow Rate as the overall patient count, divided by the
hours (amount of time converted into hours) of simulated time. This then allows us to show an
overall flow rate in the 5th report element:

Average Flow Rate Per Hour: Patient Count / Elapsed Time in Hours [Custom Statistics]
55.31

The 6th report element gives us supporting information on time and waiting (including the
inventory figures we used to answer questions 2 and 3 of the exercise). This report element
allows us to use Little’s Law to calculate flow rates and other information for each activity, or for
the process overall. Note that you would need to use the elapsed simulation time, shown in the 4th
report element, to get flow rates for each activity:
Avg.: Flow Time, Wait Time, # Waiting, Inventory; & Tot. Count: @ Activity [Activity Statistics] (Minutes)
Avg Cycle

Avg Wait

Tavg # Wait

Tavg # AtAct

Count

06 - Discharge from ER

0.00

0.00

0.00

0.00

83638

01 - Start

0.00

0.00

0.00

0.00

92958

02 - Registration

7.21

5.22

4.82

6.65

92955

04 - Serious?

0.00

0.00

0.00

0.00

92936

07 - Detailed Examination

30.07

0.00

0.00

2.77

9291

08 - Admit to the Hospital

0.00

0.00

0.00

0.00

9291

05 - Order Prescription

4.99

0.00

0.00

4.14

83638

03 - Greet the Patient

37.17

37.17

34.27

34.27

92936

Note that the 7th (final) report element shows the cycle times by patient type; those discharged
from the ER after their prescription is ordered, and those admitted to the hospital. This is
accomplished through the use of the Monitors, described earlier. Again, you may review the
monitors defined by going to the Model menu, and choosing the Monitors command. To review
how the monitors are shown in the report, double-click the second report element in the Custom
tab of the report; this edits the report element, and will show you how it is defined. If you wish to
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create your own report elements, you may either edit the existing ones, or from the Report menu,
choose Add Element. Shown below is the 7th and final report element, showing flow time by
patient type:

Average Flow (Cycle) Time by Patient Type in Minutes [Monitor Statistics]
Discharge

49.37

Admit

74.54

You may also review information not asked for by the exercise, such as statistics for overall
resource cost or per-patient (per-transaction) cost. For example, click on the “Cost” tab of the
iGrafx simulation report to review cost-related statistics.

Exercise 3.4, Running Additional Experiments
Now that you have a general-purpose simulation model of your ER, you may run additional
experiments using iGrafx. For example, you may want to consider doing one of the following to
observe the resulting impact on the behavior of the process:
1.
2.
3.
4.

Change the arrival rate for patients (using the Generator).
Change the staffing level of the ER. Add or remove a Doctor or Nurse.
Change the percentage of patients admitted to the hospital
Change the amount of time it takes to register or treat a patient.
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